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Preface

Students can now study the basic scientific principles on the same world-class equipment used by
leading researchers in the university and government labs and more excitingly, NASA. With
advances in electro-optics and their continuous impact on the sensing community, high-speed
array detectors, inexpensive optical fibers and powerful computers have made optical
spectroscopy the sensing technique of choice for many real-world applications.

The development and marketing of scientific instruments and methods have changed in an
equally dramatic way; in the past, cutting-edge instrumentation started with expensive research
devices that were accessible only to well-funded research and development enterprises, gradually,
the technologies filtered into general laboratory use, application-specific instruments and now
into the educational settings.

Our knowledge of spectroscopy has been based upon years of experimentation in a wide array of
disciplines ranging from art to applied physics. All of the fields have strong roots in education,
more specifically teaching and learning the basics of the field. It has been the experience of
thousands of science educators that have utilized the Ocean Optics spectrometers with there own
specific real world exciting experiments that the students in there classes lives have been enriched
and have a greater appreciation for science.

It is important that today's science and engineering students appreciate the capabilities of optical
sensing, the fundamental physics of the measurement process, the design trade-offs inherent in
selecting and integrating components, and the discipline required to produce quality results. The
goal of this lab manual is to provide a vehicle to allow future scientist to study the fundamentals
of spectroscopy using modern research/industry instrumentation.

Part A of this manual is a series of activities to teach the basic ideas and use-cases of
spectroscopy. Part B is a series of experiments that can be incorporated into traditional
curriculum while still exposing students to optical sensing.

I would like to offer special thanks to the educators who contributed to this lab manual as part of
the ongoing Ocean Optics grant program. Also my deepest appreciation to Kristin Detwiler for
her ground breaking work in this project.

Note to Educators: If you would like to contribute to future compilations, please send an email to
education@oceanoptics.com.

Copyright © 2006 Ocean Optics, Inc.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, by any means,
electronic, mechanical, photocopying, recording, or otherwise, without written permission from Ocean Optics, Inc.

This manual is sold as part of an order and subject to the condition that it shall not, by way of trade or otherwise, be lent, resold, hired
out or otherwise circulated without the prior consent of Ocean Optics, Inc. in any form of binding or cover other than that in which it
is published.
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All products and services herein are the trademarks, service marks, registered trademarks or registered service marks of their
respective owners.

Limit of Liability

Ocean Optics has made every effort to ensure that this manual as complete and as accurate as possible, but no warranty or fitness is
implied. The information provided is on an “as is” basis. Ocean Optics, Inc. shall have neither liability nor responsibility to any person
or entity with respect to any loss or damages arising from the information contained in this manual.
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Spectroscopy 101

Spectroscopy Concepts

Overview

Scientific discoveries are based on observations. Scientists look for patterns in what they see,
hear, feel, smell and taste to formulate theories and make predictions. Originally, scientists
depended solely on their own senses to make observations. But as science has evolved, scientists
have developed instruments to extend their observational powers beyond our sensory limits.
Telescopes have enabled astronomers to see more of the sky and vastly improve our
understanding of the heavens. Likewise, microscopes have enabled biologists to view ever
smaller parts of living organisms in their quest to understand living systems.

Astronomers are only limited by the size of the telescopes they can build and the distorting effects
of the earth's atmosphere. As technological developments have allowed for bigger mirrors and
space-based platforms, astronomers have been able to see ever further into space and make more
and more discoveries. Unfortunately, the situation is very different going in the other direction.
There is a physical limit to the size of objects that can be "seen". This limit is due to the nature of
light itself.

Light

Light is also known as electromagnetic radiation. Light consists of photons, little

. . Th eonapetc e
packets of energy that have properties of both particles and waves. All waves vt
have a wavelength, the length of one complete cycle of the vibration. For light, e —
the range of possible wavelengths is enormous. Figure 1 gives the range of wia

Hm Canradas

known wavelengths of electromagnetic radiation and the common names given to
radiation of particular wavelengths.

It is the wave properties that limit our ability to use light to create images. For
any given wavelength, that light can only be used to form images of things that
are larger than that wavelength. For visible light, with wavelengths between 4 x
107 and 7 x 107 m, it is impossible to form images of atoms which have sizes on
the order of 10” m. Very large molecular assemblies such as chromosomes

e
m
0 | T -ij

(DNA molecules coated with protein molecules) are the smallest things we can na e

pEY

"see" by forming an image.

Wm |1

The problem faced by chemists, biochemists and microbiologists is to gain an
understanding of what happens at the atomic and molecular level without me

I

actually being able to "see" atoms and molecules. Even though we can't make - -
images of atoms and molecules, we can use light to learn about the structures of e s
atoms and molecules. This is because atoms and molecules can absorb or emit " I S ) I
light. By looking at the light that is absorbed or emitted we can learn about the -

species involved. The technique for looking at such light is referred to as

0n
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L= 2, A=Z035Tom, u=nicrorete, nun=nillneer,
eoreenimeter, mmeter, Euebilometer, Mri=Viegameer

spectroscopy. It is the only tool available to astronomers to collect information

about the cosmos. It is the most powerful tool available to scientists to study

atoms and molecules, a technique that is universally used in science and Figure 1. Wavelength
engineering disciplines. Ranges
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Wavelength and Energy

Our understanding of the nature of light is a rather recent development. For a long time the
different forms of electromagnetic radiation were thought to be different phenomena. Thus, we
have the collection of common names ending in -wave and —ray for the various wavelength
ranges. This is because the energy of a photon is related (inversely) to its wavelength.

hc

A

A Eqn. 1

Where:

E = energy of the photon in joules
A = wavelength in nanometers

h = Plank's constant

¢ = speed of light

The shorter the wavelength, the higher the energy of the photon.

Because the wavelength range of known electromagnetic radiation is enormous, the difference in
energy of photons is also enormous. And it is this energy that will determine the effect of the
photon when it interacts with matter. The radio frequency photons have very small energies
which is why we can saturate our atmosphere with them without affecting our environment. The
amount of energy they impart to the atoms that absorb them is almost negligible. Infrared photons
have enough energy to heat objects and, as a result, they make great heat lamps. Ultraviolet
photons have enough energy to break chemical bonds and can cause molecular rearrangements
resulting in effects like sunburn and genetic damage. X-rays are very energetic and readily break
even the strongest bonds causing significant molecular destruction. For this reason the medical
use of X-rays is destructive of living tissues and must be done carefully and only in extremely
small doses.

The Interaction of Light with Matter

To be more correct, it is usually the electrons in atoms and molecules that absorb and emit
photons of light (Gamma rays are energetic enough to interact with atomic nuclei, but we'll leave
that topic to the physicists to pursue). An electron can absorb low energy photons, like radio
frequencies, by flipping its "spin". This effect is used to create nuclear magnetic resonance
spectroscopy (NMR) and magnetic resonance imaging (MRI). An electron can absorb infrared,
visible and ultra violet photons by changing its energy level. All electrons have a series of energy
levels they can occupy. The lowest energy level is referred to as the "ground state". The highest
level is the "ionization energy", the energy required to completely remove the electron from the
influence of the nucleus. In order for an electron to move from one level to a higher level it must
absorb energy equal to the difference in the levels. Likewise, to move to a lower level the electron
must give up energy equal to the difference. Because there are a limited number of levels the
electron can occupy, there are limited amounts of energy it can absorb or give up.

2 © 2007 Ocean Optics, Inc.
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A more detailed discussion can be found in Chemistry and

. R Chemical Reactivity, Chapter 7 by Kotz and Treichel. Their

3d figure 7.13 is a detailed presentation of the electronic transitions
possible for the simplest atom, the hydrogen atom. Figure 2 is a
diagram of the most common transitions possible for a sodium
atom. The 3s to 4p transition is in the ultraviolet range. The 3p to
3d transition is in the infrared range. And the 3s to 3p transition
is in the orange region of the visible spectrum. This line is the
source of the characteristic color of sodium vapor lamps.

4s

330 nm 1
818 I

There are a number of ways an electron can gain or lose energy.
The one of interest here is the absorption or emission of light. An
e electron can absorb a photon of light that strikes it only if that
photon has the exact energy to change the electron to a higher
allowed energy level. An electron already at a higher level can
Figure 2 emit a photon of light having exactly enough energy to change
that electron to one of its lower allowed levels. Notice that an
electron in the ground state cannot emit any photons as it already
has the least possible energy.

__589 nm

The magnitude of the difference in allowed energy levels determines which kinds of light can be
used to study particular atoms and molecules. While spectroscopy is conducted in nearly all
regions of the electromagnetic spectrum, practical considerations make the infrared, visible and
ultraviolet regions the most useful in chemical laboratories. Infrared spectroscopy is particularly
useful for studying the bonds between carbon, hydrogen, oxygen and nitrogen atoms that
predominate in organic compounds. Thus, infrared is a key tool of the organic chemist. Infrared
spectra can indicate the presence of particular structures in unknown organic compounds by the
presence of characteristic features. They can also be used to confirm the identity of compounds
by comparison with known spectra. Reference books containing thousands of spectra of known
organic compounds are available for this purpose.

Visible light spectroscopy is particularly useful for studying certain kinds of organic compounds
and elements that have electrons in d-orbitals, such as transition metals. Ultraviolet spectroscopy
is useful for studying certain kinds of organic compounds that predominate in biological contexts.
All proteins have useful ultraviolet spectra as do DNA and many reaction co-factors. Many
biochemical reactions can be effectively monitored in the ultraviolet and this tool is commonly
found in biochemical laboratories. In clinical laboratories, ultraviolet spectroscopy is often the
means for making quantitative determinations on plasma and urine samples.

Types of Spectroscopy

Spectroscopy is the study of the interactions of light with matter. There are two distinct aspects of
this interaction that can be used to learn about atoms and molecules. One is the identification of
the wavelengths of light that interact with atoms and molecules. The other is the measurement of
the amount of light being absorbed or emitted at any particular wavelength. Both determinations
require separating a light source into its component wavelengths. Thus, a critical component of
any spectroscopic measurement is the breaking up of light into a spectrum. For each of these
aspects there are two ways observations can be made: the light that is absorbed by atoms and
molecules, and the light that is emitted. This creates a total of four different kinds of
spectroscopy: absorption, emission, qualitative and quantitative.

© 2007 Ocean Optics, Inc. 3
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Absorption Spectroscopy

Absorption spectroscopy is the study of light absorbed by molecules. In it, white light is caused to
pass through a sample and then through a device (such as a prism) that breaks the light up into a
spectrum. You will recall that white light is a mixture of all wavelengths of visible light. When
such light is passed through a sample, under the right conditions, the electrons of the sample will
absorb those wavelengths of light that can change them to other levels. Thus, the light coming out
of the prism will be missing those wavelengths corresponding to the allowed energy levels of the
electrons in the sample. We will see a spectrum with black lines where the absorbed light would
have been if it had not been removed by the sample.

Emission Spectroscopy

Emission spectroscopy is the opposite of absorption spectroscopy. The electrons
of the sample are promoted to very high energy levels by any one of a variety of ~ oBNa b
methods (e.g., electric discharge, heat, laser light, etc.). As these electrons return L e
to lower levels they emit light. By collecting this light and passing it through a | ;
prism, it is separated into a spectrum. This time, however, we will see only a dark
field with colored lines that correspond to the electron transitions. Figure 3 shows
the view through the telescope of the 589 nm Helium emission line with a scale Figure 3
superimposed. Notice that the absorption and emission spectra of the same

substance will have the same values for wavelength. In the absorption spectrum

these values will appear as black lines on a colored field whereas in the emission

spectrum they will be colored lines on a black field.

Qualitative Spectroscopy

One of the useful aspects of spectroscopy derives from the fact that the spectrum of a chemical
species is unique to that species. Identical atoms and molecules will always have the same
spectra. Different species will have different spectra. Thus, the spectrum of a species can be
thought of as a fingerprint for that species. Qualitative spectroscopy is used to identify chemical
species by making a spectrum and comparing it with known spectra to find a match.

As an example, consider the discovery of the element Helium. It was first observed, not on the
earth, but in the sun! In 1868the French astronomer, Pierre-Jules-Cesar Janssen, was in India to
observe a solar eclipse when he detected new lines in the solar spectrum. No element known at
that time would produce these lines and so he concluded that the sun contained a new element.
This initiated a search for the new element on planet earth. By the end of that century, the new
element had been identified in uranium ores and was named Helium after the Greek word for the
sun (Helios). Today, spectroscopy finds wide application in the identification of chemical species.

Quantitative Spectroscopy

Quantitative spectroscopy is one of the quick and easiest ways to determine how many atoms or
molecules are present in a sample. This is because the interaction of light with matter is a
stoichiometric interaction. At any given temperature, the same number of photons will always be
absorbed or emitted by the same number of atoms or molecules in a given period of time. This
makes spectroscopy one of the few techniques that can provide a direct measure of the number of
atoms or molecules present in a sample.

4 © 2007 Ocean Optics, Inc.
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Quantitative emission spectroscopy requires samples be heated very hot to enable electrons to
emit light. Most often, this is done by feeding the sample into a burner flame. As a result, it is not
practical for use with most molecular compounds. It is frequently employed for elemental
analysis. A quantitative emission technique, flame photometry, is employed in clinical labs to
determine sodium and potassium levels in blood plasma and urine.

Lreaung a flame

Figure 4
Because quantitative absorption spectroscopy can be done at room temperature, it is the more
common technique. It is usually performed on samples dissolved in solution. In clinical labs,
determinations of the amounts of compounds like glucose and cholesterol in blood and urine
samples employ this technique.

. . . . 412 nm
Absorption spectroscopy is performed by passing light of all wavelengths 541 nm

through a sample and measuring how much of each wavelength is absorbed. 576 nm
The statement made above that "the absorption spectrum will appear as black
lines on a colored field" is a considerable oversimplification. The complex
interactions of atoms and molecules with water molecules in solution make
the absorbance of light in solutions a very complex phenomenon. L. s ]
Nevertheless, the patterns are repeatable and predictable, thus making 400 500 600
them useful. By making absorbance measurements at various Wavelength (nm)

Absorbance

wavelengths and then plotting the result, one can create what is known as Absorbance spectrum of hemoglobin
an absorbance trace. in the visible region.

Figure 5 is an example of such a trace. Absorbance traces are like
fingerprints. Each compound has its own unique trace. In some cases this
can be used to identify the presence of certain compounds in a sample.
More often, it is used to determine the amount of compound present.

Figure 5

Color and Wavelength

The visible region is a good place to begin an investigation of spectroscopy because it is a critical
feature of our everyday world. This phenomenon is known as color vision. Our perception of
color is the eye's response to light of different wavelengths. When photons of a narrow
wavelength range interact with our retina, we perceive the effect as color. Thus, the apparent
color of an object is due to the wavelengths of the photons of light reaching our eyes from that
object. This is true whether the object is emitting its own light or reflecting light from another
source. In a sense, our eyes operate like spectrophotometers.

White light is an equal mixture of light of all wavelengths (colors). When such light strikes an
object and is completely reflected, we see equal amounts of light of all colors and perceive the
object to be white. When all light striking an object is absorbed, no light enters our eyes and we
perceive the object to be black. A sheet of paper is white because all light striking it is reflected
and none is absorbed. The print on the paper is black because all light striking it is absorbed.
None is reflected. We perceive color when some wavelengths of light are reflected (or
transmitted, as in the case of a solution) more than others.

© 2007 Ocean Optics, Inc. 5
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There is a rather complex pattern to the absorption of light by colored objects. The statement that
"an object appears red because all red light is reflected and all other light is absorbed" is a
considerable oversimplification. In fact, varying amounts of light of different wavelengths are
absorbed in most colored objects and the color we perceive is more closely related to the color
that is most absorbed rather than to the color that is reflected.

The brain assigns color to an object by a process known as complementary color vision.
According to this theory, all colors of light have a complementary color. This is often displayed
through the use of a "color wheel" like the one shown in Figure 6. A color and its complementary
color are opposite each other on the color wheel. The perception of color occurs when the optic
nerve and the brain compare the amount of light of a particular color with the amount of its
complementary color. If the two amounts are the same, we see gray or white. If not, we see color.
Thus, a fire extinguisher appears red in white light because more blue-green light (the
complementary color of red) is being absorbed than any other color. Of course, this also means
that more red light is being reflected than its complementary color, blue-green. For all other
colors, relatively equal amounts of each color, and its complement, are being reflected.

red
red crange
arange
indigo 5 yellow orange
deep blue vellow
vellow green

green

Figure 6. Color Wheel

Instruments that Generate Spectra

There is a large variety of instruments used to perform spectroscopy. They differ greatly in the
kinds of information they provide. What they all have in common is the ability to break light up
into its component wavelengths.

Spectroscopes

A spectroscope is simplest of spectroscopic instruments. Its function is to take light from any
source and spread it into a spectrum for viewing with the unaided eye. Figure 7 is a diagram of a
simple spectroscope. The light from the source passes through the slit and into the prism where it
is spread into a spectrum. The telescope is used to focus on the light coming out of the prism. The
third arm contains a wavelength scale that can be superimposed over the spectrum by shining a
white light into it. Figure 3 shows a view through a spectroscope's telescope. Spectroscopes are
useful for determining what wavelengths of light are present in a light source, but they are not
very useful for determining the relative amounts of light at different wavelengths. Spectroscopes
are most commonly used for qualitative emission spectroscopy.

6 © 2007 Ocean Optics, Inc.
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—
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lelescope

Figure 7. Diagram of a spectroscope.

Spectrometers

A spectrometer is a spectroscope that has some sort of meter attached that can measure the
amount of light (number of photons) at specific wavelengths. Thus, it is designed to provide a
numerical measure of the amount of light emitted or absorbed at a particular wavelength. It is
constructed so that the wavelength can be varied by the operator and the amount of radiation
absorbed or transmitted by the sample determined for each wavelength. In this way it is possible
to learn which wavelengths of radiation are present and in what relative amounts. Spectrometers
are common in astronomy where they are used to evaluate the light collected by telescopes. They
are the only source of information we have about the chemical composition of the universe
outside our own solar system.

entrance

; monochrometer
slit
I diteantian 1
light I i |
o e I
be b - amplifier
analyzed l | I r
| . g e 11
obiective |
lens J - detector
| mirror exit! 0.052
!_ ............ S"B readout
display

Figure 8 Schematic representation of a simple spectrometer.

Light enters the spectrometer via the entrance slit and then passes through several parts: an
objective lens, a grating, and an exit slit. This combination of parts functions as a
monochromator, a device which selects only one color (actually, a narrow band of wavelengths)
from all of the wavelengths/colors present in the source. A particular wavelength is selected,
using the wavelength control, by adjusting the angle of the grating. This works because different
wavelengths of light reflect off the grating at different angles. The net result is the separation of
white light into a "rainbow" much like light transmitted through a prism of glass. The selected
wavelength is at the center of the narrow band of wavelengths passing through the slit.

© 2007 Ocean Optics, Inc. 7
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The light then strikes a detector that generates a voltage in proportion to the intensity of the light
hitting it. That voltage is then used to drive a read-out device that is designed to provide data in a
useful fashion such as intensity.

As with all electronic devices, the design and operation of spectrometers had been greatly
impacted by the developments of the latter half of the 20th century. Perhaps the most crucial was
the development in the early 70's of the Charged Coupled Device (CCD). Originally conceived as
a new mode of data storage, it was soon discovered that CCDs held great promise as imaging
devices. An imaging device is something that electronically mimics what photographic film does.
Charged Couple Devices consist of a number of elements between which charge can be shifted.
In an image sensor, light falling on the array of elements produces a pattern of charges
corresponding to the image. This image can then be electronically transported to some other
location, such as a monitor, and reconstructed. CCDs were first employed to replace photographic
plates in telescopes. The first such device was installed on the [-meter telescope at Kitt Peak
National Observatory in 1979. Today, CCDs are the detectors that make digital cameras not only
possible, but affordable.

Soon after its successful application to astronomical problems, it was determined that CCDs
could greatly enhance the performance of spectrometers. This was achieved by replacing both the
exit slit and detector with a CCD array. Now, it was no longer necessary to measure light
intensity one wavelength at a time. The number of wavelengths that can be monitored
simultaneously is determined by the number of elements in the CCD array. Figure 9 is a
schematic of a spectrometer outfitted with a CCD array. The array generates an output that can be
used to reconstruct the intensity of light striking each of the elements in the array. This output can
be sent to a monitor or a printer for display. The output is instantaneous across the spectrum. No
longer is it necessary to "scan" back and forth across the spectrum to identify light intensity at
individual wavelengths.

entrance
slit

diffraction
| grating

image

objective
lens

mirror CCD
array output
display

Figure -9 Schematic representation of a CCD spectrometer.
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Spectrophotometers

Since spectrometers measure the amount of light entering the instrument, they are most often
used for emission spectroscopy. In order to perform absorption spectroscopy, a light source of
known intensity is required. An instrument that includes such a light source is known as a
spectrophotometer. It is constructed so that the sample to be studied can be irradiated with light
of known wavelength and intensity. The wavelength can be varied and the amount of radiation
absorbed or transmitted by the sample determined for each wavelength. From this information, an
absorption spectrum for a species can be obtained and used for both qualitative and quantitative
determinations.

Spectrophotometers measure the amount of light transmitted by a sample and then convert this to
more useful measures. One is the ratio of the transmitted light (I) to the incident light (1,,),
expressed as a percent. This is known as the percent transmittance (% T).

7= (1 Jx100%

Eqn. 2

The %T calculation is easy to design into a spectrophotometer and was a common output before
the advent of computer chips. A more useful quantity is the absorbance, A or Abs, because it is
directly related to the molar concentration of the chemical species doing the absorbing.
Absorbance values can be obtained from % T values using the following expression.

1 L
A=L =log| — Egn. 3
°g(%T) Og(fj b

There is an assumption inherent in the calculation of either %T or absorbance. The assumption is
that all light not transmitted to the detector is absorbed by the chemical compounds in the
solution. Two other possibilities exist. One is that the light is being scattered by the solution.
Samples containing solid material, or which are cloudy, are difficult to analyze using a
spectrophotometer. Samples encountered in the commercial world (biological fluids, soil
solutions, etc.) are often cloudy and extra steps must be employed before analysis by absorption
spectrophotometry can begin.

The other assumption is that light might be scattered or absorbed by the container used to hold the
solution. Care must be taken to ensure that the sample cells do not affect the measurement. The
cells must be constructed of absolutely clear glass. If measurements are to be made below 350
nm, they must be made of quartz glass. Regular glasses are opaque below 350 nm.

The Beer-Lambert Law

The relationship between absorbance and concentration is known as the Beer-Lambert Law, or
sometimes simply Beer's Law,

A =¢bc Eqn. 4

© 2007 Ocean Optics, Inc. 9
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Where:

A = measured absorbance,

¢ = concentration of the absorbing species,

b = path length of the sample (width of the cuvette)

& = a proportionality constant known as the molar absorptivity with units of (M'em™).

The molar absorptivity is constant for a specific chemical compound and a specific wavelength.
For most compounds there is typically at least one wavelength where € reaches a maximum. This
wavelength is often chosen to carry out absorption spectrophotometry of that compound. For
example, consider the visible spectrum of hemoglobin (Figure 5). There are three wavelengths in
the visible range that would be suitable: 412, 541 and 576 nm.

If the molar absorptivity is known at a particular wavelength, the concentration of a chemical
compound present in a transparent sample can be calculated from the measured absorbance using
Beer's Law. The simplest way to determine ¢ is to take a solution of known concentration, select
the wavelength for which the value of € is desired (usually the wavelength where the absorbance
has its greatest value), measure the absorbance there and measure the path length. The above
equation can be rearranged to solve for € (¢ = A / bc) and the value computed from the
experimental measurements. The result, however, may not be reliable. For example, the Spec 20,
one of the spectrophotometers available for your use, produces reliable results only in the
absorbance range of to 0.01 to 1.5. A value outside this range will have questionable meaning. It
is also possible for the instrument to malfunction or to be operated improperly. Therefore,
multiple measurements of a number of samples under a variety of conditions are required to
provide a believable answer.

A more accurate method to determine ¢ is to measure the absorbance of a number of solutions of
different concentrations and construct a calibration plot. Beer's law is a linear equation of the
form

y=mx +b

(b, the y intercept, is zero and therefore does not appear in the Beer's law equation.) A plot of
absorbance vs. concentration should produce a straight line with a slope equal to eb. Figure 10 is
a representation of such a plot. Because the intercept is zero, a concentration value of zero should
produce a zero absorbance and the origin of the plot (0, 0) should be a point on the plot.

R R Determining E requires determining the
g slope of the best-fit line through the data

8 o =3 * points. Consider the data graphed in

£ a0 ai Figure 10. By selecting two points on

2 i : the line and reading their coordinates,

2 | | )

L vl T s | | ; the slope can be calculated. To avoid
T e o ey s e U8 biasing the readings, the points selected

for this determination should not be the

Figure 10 Sample concentration (M) !
same as any of the data points.

i .70 - 0.10 :
f‘;‘ i‘ = O = 1.6 x 10* M Eqn. 5

8= Hlape = O, 4.4x10° M - 0.60x 10° M
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As long as the path length through the sample can be measured, € can be calculated from the
slope. One way to measure the path length is with a ruler. A more rigorous method is to measure
the absorbance of a standard solution having a known concentration and molar absorptivity and
then calculate the path length from Beer's Law.

Note that the value of b may vary from cuvette to cuvette. It will also vary with the orientation of
the cuvette in the sample holder if the cuvette does not have a uniform diameter in all directions.
To maintain optimal accuracy, one should always use the same cuvette and make sure it is
oriented the same way every time it is placed in the spectrophotometer.

It is possible to read the concentration of an unknown sample directly from a calibration plot by
interpolation using the measured absorbance of the unknown sample. In the example shown in
Figure 11, an absorbance reading of 0.45 produces a concentration of 2.7 x 10 M.
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Figure 11. Interpolating Concentrations from a Beer’s Law Plot
Instrumentation

Three different instruments are currently available for you to use to make
spectroscopic observations and measurements. They are described here.

Gaertner® Spectroscope

This instrument is little changed from the spectroscopes used by
Gustav Kirchhoff and Robert Bunsen (the father of the burner
that carries his name) to develop the science of emission
spectroscopy during the 1850's. It is pictured in Figure 12 and is
schematically represented in Figure 7. It can be used to perform
qualitative emission spectroscopy on sufficiently bright light
sources. The following is an outline of its operation.

1. Note the narrow slit in the end of the light collection tube. Aim this directly at the light to
be studied. Looking through the telescope, and grasping it by its base, move the
spectroscope back and forth until the light you see in the spectroscope is brightest. If you
see no light, you many need to move the telescope back and forth using the positioning
control directly underneath. (It's best to begin with the telescope in the middle of its range.)

2. Turn on the desk lamp and shine it through the scale illuminating tube. Look into the
telescope and observe the scale. If it is not exactly horizontal in the field of view, gently
twist the end of the scale illuminating tube until it is.

© 2007 Ocean Optics, Inc. 11
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3. Move the telescope lens in or out to bring the position scale into focus. Once the
spectroscope is aligned, avoid moving it.

4. Move the telescope back and forth using the knob below it to view the entire spectrum.
Look down the telescope and read the positions of the colored lines on the illuminated
scale. Record these readings in your notebook. You should be able to interpolate the
positions to 0.01 (there are no units). The best strategy is this: instead of trying to determine
the position of the center of a line, find the position of the sharp edge. Each line will have a
sharply defined edge on the left side and a diffuse edge on the right.

Ocean Optics USB4000 Spectrometer

This is a quick and easy-to-use instrument for generating UV and visible region spectra from any
light source. The spectrophotometer (mirrors, grating, slit, and detector) are housed in an optical
bench that’s small enough to fit into the palm of your hand.

Figure 13. Ocean Optics Spectrometer Toshiba Linear Detector

The spectrometer accepts light energy transmitted through an optical fiber or free spaced and
disperses it via the fixed grating across the linear CCD detector that is designed to provide output
readings at 3648 evenly-spaced locations in the wavelength range of choice. The output from the
detector is then fed into the computer via USB to software, processed, and displayed on the
monitor as "counts" per millisecond. (One "count" is equivalent to one photon hitting the chip).
Thus, the display you see is the result of more than 3500 different outputs being fed into the
computer and processed. This happens fast enough for you to be looking at the spectra generated
by the instrument in "real time".

Emission Measurements Using Ocean Optics’ SpectraSuite Software

1. Start Spectrasuite by clicking the Start button, then selecting All Programs | Ocean

Optics | SpectraSuite | .SpectraSulte Figure 14 is the toolbar that will appear at the
top of the screen.

12 © 2007 Ocean Optics, Inc.
Vernier Software & Technology



Spectroscopy 101

EﬂceanﬂpticSSDectraSuite ' Jﬂ_)
Fle Yiew Spectrometer Processing Took Window  Help

I Integration il Sansto | Boxear | +| StrobefLamp Electric datk -

‘ time: 100 rikencs ¥ average: 1z width: 5 Enable: r corection; e @ 1L B
. Nonivestty - Syl - Brtemd :

L | b ormal I I

‘ i %correction: |-currection: r}f@@e“ ‘ I il ’

 Data Sources 1 X‘ [ Grath (4] X} K5

s\ njalalale]4| 0].] s|+|AlT|r|z| |/alz|a/a]

R

L15B650

Figure 14. SpectraSuite toolbar

2. Turn on the high voltage source to light the Helium discharge tubes. Adjust the voltage
control until the tubes are glowing steadily (if applicable). Do not use maximum output
without consulting your instructor.

CAUTION

The power supply that lights the discharge tube generates a voltage of from
5000 to 7000 volts. Avoid nasty shocks by not touching exposed metal
connections.

3. Align the optical cable on the discharge tube and adjust it until the lines in the SpectraSuite
window have their maximum height.

4. Inspect the spectrum. The top should be near the top of the window, but not off scale. If it is
too big or too small, it will be necessary to adjust the integration time to produce the best
possible spectrum. The integration time is the time, in milliseconds, that the instrument
counts photon for display on the screen. Finding the best integration time is a process of
trial and error. Find the integration time control on the left side of the toolbar and adjust it
until you are comfortable that the maximum signal is the right size. For emission spectra, it
may be necessary to use a large integration time to identify very weak peaks.

5. When you are happy with the spectra click the Save icon (E) in the SpectraSuite toolbar.

Name and save the file. Then click the Overlay Spectral Data icon ( = ) from the
SpectraSuite toolbar to allow you to view and analyze the captured spectra.

6. Click on the screen to activate the cursor. This will be used to identify wavelengths and
signal strengths for each line or peak you are interested in. Click on the screen and the
cursor will move to that location. Identify the wavelengths of all the lines that you can
identify. Record both the wavelengths and signal intensities in your notebook.

7. Carefully move the helium discharge tube aside and replace it with the hydrogen discharge
tube. Adjust the optical cable so that the lines are as bright as possible. Again, use the
cursor to read the positions and intensities of the lines. There will be a smear of color in the
orange-to-yellow region. Do not record readings for any lines you may observe in this
region. These lines arise from a different phenomenon than the other lines and do not fit the
mathematical treatment.

© 2007 Ocean Optics, Inc. 13
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8. Repeat Steps 2 through 6 using the hydrogen discharge tube.

Ocean Optics USB4000 as a Spectrophotometer

The USB spectrometer can also make absorbance measurements when used in conjunction with
the tungsten light source and cell holder pictured in Figure 16. To measure absorbance, the
instrument must be calibrated. This is done by first recording the number of counts at each of the
2048 elements from the pure light source as it passes through a reference solution (water). Next,
the number of counts when the light source is blocked is recorded. Both of these operations are
automatically performed by the software when the appropriate buttons are pushed. Once the
instrument has been calibrated and a sample is inserted in the holder, the computer calculates the
ratio of the counts hitting the detector to the stored reference counts for each of the 2048
elements, converts these to absorbance values, and plots the result on the screen. Again, the
computer operates at a speed that makes all this appear to happen instantaneously.

Figure 15

Using SpectraSuite to Make Absorption Measurements
1. Start Spectrasuite by clicking the Start button, then selecting All Programs | Ocean

Optics | SpectraSuite | .SpectraSulte Figure 16 is the toolbar that will appear at the
top of the screen.
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Figure 16. Spectrasuite toolbar

2. Record a spectrum of a cuvette filled with the solvent (water) and save it as the reference

spectrum. To do this, select File | Store | Store Reference Spectrum or click “inthe
graph toolbar.

14
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3. Completely block off the light source by inserting a piece of dark paper between the light
source and your cuvette. Select File | Store | Store Dark Spectrum from the menu to save

a dark spectrum to a file. You can also click ¥ in the graph toolbar. Then, remove the
paper you inserted in front of the light source.

4. Click on the Absorbance mode icon ( A ). This will put the spectrophotometer into the
Absorbance mode. You are now ready to generate absorbance spectra.

i}

and Manually Set Numeric Ranges ( @ ) functions. For this experiment, you will want to
use the "set scale" function to reset the wavelength scale to from 400 to 700 nm.

5. You can adjust the display parameters using the Scale Graph Height to Fill Window (

6. Rinse the cuvette with the solution to be tested and fill it with the same solution. Insert the
cuvette in the chamber. Take a snapshot of the spectrum by selecting File | Screen
Capture, then clicking the Accept button in the dialog box that appears. This freezes the

spectrum on the screen. Print your data by clicking on the printer icon ( =] ) on the
SpectraSuite toolbar.

7. Repeat Step 6 until all the dyes have been tested.

Spectronic 20® Spectrophotometer

This is the best known and most widely used spectrophotometer ever built. First introduced over
40 years ago, this rugged and reliable instrument can provide accurate absorbance readings in the
325 to 650 nm range. What it does not do is provide is complete spectra: it only provides single
readings at single wavelengths.

The Spec 20™ employs the same simple spectrometer design as shown in the schematic of Figure
17. The light source is a tungsten lamp and the slit is about 20 nm wide.

Figure 17. Spec 20°

The output of the lamp and the response of the detector differ greatly over the visible spectrum.
Unlike the Ocean Optics USB4000 Spectrometer, it does not store reference spectrum and dark
current information. Thus it is necessary to re-zero the instrument every time the wavelength is
changed. Once the instrument is at a particular wavelength, it is most efficient to measure the
absorbance of all solutions before moving on to a new wavelength.

© 2007 Ocean Optics, Inc. 15
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The Spec 20" should work reliably at wavelengths between 400 and 640. They often work as low
as 325 nm. For wavelengths below 400 and above 640, if you can get the instrument to zero, you
should go ahead and make the measurements.

Using the Spec 20°

The following is an explanation of the instruction outline that appears on most instruments
(Figure 18).

Abzorbance [
Power Indicator Transmittance Dizplay
Light a

Sample e avelengih
Cnmpam Belector

Power Switch Ahmi?mt: !
Fero Control Transmiitanee
[ e e e

Figure 18

1. Set the wavelength to the desired value using the knob next to the wavelength window.

2. With nothing in the sample compartment, set the infinite absorbance adjustment. This is
done by adjusting the left front dial until the meter reads infinite absorbance.

3. The Spec 20 uses round cuvettes; 4" test tubes are the ideal size. Since they are not uniform
in diameter, they should always be aligned the same way when inserted in the sample
holder.

4. Set the zero absorbance adjustment. Insert the reference cuvette (a clean cuvette containing
distilled water) into the sample compartment making sure it is properly aligned. Make sure
the sample compartment lid is closed. Adjust the right front dial until the meter reads zero
absorbance. Note that this control will be adjusted many full turns over the range of
wavelengths used.

5. Replace the reference cell with a sample cuvette. Align the cuvette. Make sure the sample
compartment lid is closed. Read and record the absorbance.

16 © 2007 Ocean Optics, Inc.
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Investigating the Beer-Lambert Law

The direct relationship between absorbance and concentration for a solution is known as the Beer-
Lambert Law, or more commonly Beer’s law. You can use Beer’s law to test several samples of a
solution, of known molar concentrations, and calculate a best-fit line equation to relate the
absorbances of the solutions to their concentrations.

The primary objective of this experiment is to determine the concentration of an unknown
cobalt (IT) chloride, CoCl,, solution. You will first use a spectrometer to measure the absorbance
of one CoCl, solution over the visible light spectrum and select the wavelength of maximum
absorbance. You will prepare five cobalt (II) chloride solutions of known concentration, which
are your standard solutions. You will to measure the concentration of each standard solution to
establish the Beer’s law best-fit line equation for the CoCl, standards.

You will use the best-fit line function for the standard solutions to determine the molar
concentration of a CoCl, solution of unknown concentration.

Materials

Ocean Optics or Vernier Spectrometer 0.10 M cobalt (II) chloride, CoCl,, solution
computer CoCl, solution of unknown concentration
SpectraSuite or Logger Pro 3 software distilled water

cuvettes 10 mL graduated cylinders or pipettes

one dark cuvette (filled with a solid) small beakers

six test tubes plastic Beral pipettes

test tube rack

Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

Procedure A: Using Ocean Optics SpectraSuite Software
1. Label five test tubes to use for your standard solutions. Prepare the CoCl, standards
according to the chart below.

Test Tube [CoCl;] mL of 0.10 M mL of
CoCl, (aq) distilled water
1 0.02 M 2.0 8.0
2 0.04 M 4.0 6.0
3 0.06 M 6.0 4.0
4 0.08 M 8.0 2.0
5 0.10 M 10.0 0.0

2. Obtain a small amount of CoCl, solution of unknown concentration. Set it aside to test
after you have measured the absorbances of the standard solutions.

3. Fill a cuvette ~%; full with distilled water to serve as your blank.

© 2007 Ocean Optics, Inc. 17
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4. Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite
software.

5. Calibrate the spectrometer.

a.

b.

g.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the
spectrometer to warm up for at least five minutes before proceeding.

Place the blank cuvette in the spectrometer. Open the File menu and choose New
— Absorbance Measurement. The “Set Acquisition Parameters wizard” will
appear. This process has four steps. First, confirm that your spectrometer has
been identified, and then click Mets |

In step two of this process, make sure that the box next to “Strobe/Lamp
Enable” is checked. Manually select a suitable integration time by using the
arrow keys to increase or decrease the integration time, in milliseconds. Click
_tet> | proceed.

To record the absorbance spectrum of the blank (100% transmittance), click the
Store Reference Spectrum icon, «. Click _tet> |t proceed.

Remove the blank cuvette and place the dark cuvette in the spectrometer. To save
the dark reference (0% transmittance), click the Store Dark Spectrum icon, ¥.
Pour out the distilled water from the blank cuvette, rinse, and fill it with the 0.02
M CoCl, solution in test tube #1. Place the cuvette in the spectrometer. Click
I complete the acquisition parameters wizard.

A plot of absorbance vs. wavelength for your CoCl, solution is displayed.

6. Important: Examine the graph and select the peak wavelength that you wish to use for
your Beer’s law experiment.

7. Setup the Beer’s law experiment.

a.

b.

18

Open the File menu and choose New — New Concentration Measurement.

Select “Active Processing:”, and then click L2 |,

The Concentration Measurement Setup wizard appears, and its default is the
Beer-Lambert Law. Select “Calibrate from solutions of known
concentration”. Click _"> |

The Range Selection defaults to a single wavelength. Enter the peak wavelength
that you identified in Step 6, and then click tet> |

The next dialog box sets up the Beer’s law graph of your standard solutions.
Type in the molar concentration of your first sample, 0.02. Click Iml, and
then click __##43s | The absorbance of your first standard is saved and plotted
on the small graph in the dialog box.

© 2007 Ocean Optics, Inc.
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e. Remove the cuvette and dispose of the solution as directed. Rinse and fill the
cuvette with the CoCl, standard solution in test tube #2. Place the cuvette in the

spectrometer. Type in the molar concentration, click |ml, and then click
A Sampls |

f.  Repeat step e for the remaining standards. When you complete the final standard
solution (0.10 M), type in the compound name and unit of concentration (mol/L).
A best-fit line is calculated for your standards. Make sure the regression order is
set to 1. Note: To delete a data point, choose a row of data and click

[[Remmessnoe ] Cpick [CF=h ] to continue.

8. To measure the absorbance of the CoCl, solution of unknown concentration, rinse and fill
the cuvette ~% full with the unknown sample. Click Single Update and write down the
concentration of your unknown.

9. To close the SpectraSuite program, select File — Exit, and then click [res ],

Procedure B: Using Vernier Logger Pro 3 Software
1. Label five test tubes to use for your standard solutions. Prepare the CoCl, standards
according to the chart below.

Test Tube [CoCl;] mL of 0.10 M mL of
CoCl, (aq) distilled water
1 0.02 M 2.0 8.0
2 0.04 M 4.0 6.0
3 0.06 M 6.0 4.0
4 0.08 M 8.0 2.0
5 0.10 M 10.0 0.0

2. Obtain a small amount of CoCl, solution of unknown concentration. Set it aside to test
after the absorbances of the standard solutions have been measured.

3. Fill a cuvette ~%; full with distilled water to serve as your blank.

Use a USB cable to connect a spectrometer to your computer. Start the Logger Pro 3.5
software. Allow the spectrometer to warm up for five minutes.
5. Calibrate the spectrometer.

a. Open the Experiment menu and select Calibrate — (Spectrometer). The
following message appears in the Calibrate dialog box: “Waiting ... seconds for
the device to warm up.” After 60 seconds, the message changes to: “Warmup
complete.”

b. Place the blank in the cuvette holder of the spectrometer. Align the cuvette so
that the clear sides are facing the light source of the spectrometer. Click “Finish

Calibration”, and then click| ok |,

© 2007 Ocean Optics, Inc. 19
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6. Determine the maximum wavelength for CoCl, (aq) and set up the data collection.

a.

b.

Rinse and fill the blank cuvette with the 0.02 M CoCl, solution in test tube #1.
Place the cuvette in the spectrometer.

Click |pcollect | A full spectrum graph of the CoCl, solution will be displayed.
Note that one area of the graph contains a peak absorbance. Click to
complete the analysis.

(Optional) To save your graph of absorbance vs. wavelength, open Experiment
— Store Latest Run.

Click the Configure Spectrometer Data Collection icon, i, on the toolbar.
Select Absorbance vs. Concentration under Set Collection Mode. The peak
absorbance will be automatically selected. (Optional: to select a new wavelength,
click on the graph or check the box next to the desired wavelength. To start over,
click % _|and select a wavelength, or wavelengths again.) Click to
proceed.

7. Collect absorbance-concentration data for the five standard solutions.

10.

20

a.

b.

Click [» collect|. When the absorbance reading stabilizes, click [® Keep |. Enter
“0.02” as the concentration of the solution and click| ok |,

Remove the cuvette and dispose of the solution as directed. Rinse and fill the
cuvette with the CoCl, standard solution in test tube #2. Place the cuvette in the
spectrometer. When the absorbance reading stabilizes, click |® keep |. Enter
“0.04” as the concentration.

Repeat Step 7b for the remaining standard CoCl, solutions. When you have
finished testing the standard solutions, click [ ® stop |.

To determine the best-fit line equation for the CoCl, standard solutions, click the linear
fit button, <], on the toolbar. Write down the equation for the standard solutions in your
data table or lab book.

Determine the concentration of the unknown CoCl, solution.

a.

b.

Rinse the cuvette twice with the unknown solution and fill it ~ % full. Wipe the
outside of the cuvette and place it into the spectrometer.

Open Analyze — Interpolation Calculator. A dialog box will appear that
displays the concentration of your unknown at the measured absorbance.

Click[ ok | Write down the concentration of the unknown in your data table
or lab book.

(Optional) Select Save As... from the File menu and save your experiment file.

© 2007 Ocean Optics, Inc.
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Test Tube

Concentration
(mol/L)

Absorbance

1

Unknown#

Questions

1. At what wavelength did you measure the absorbance of the CoCl, standard solutions? If
you had used a wavelength 10 nm greater or smaller than your choice, how would it have

affected your results?

2. Does the temperature of the solutions matter when conducting a Beer’s Law experiment?

Explain why or why not.

3. A student prepares the CoCl, standard solutions by accidentally adding one extra mL of
distilled water to each test tube. Explain how this error will affect the determination of a
CoCl, solution of unknown concentration?

© 2007 Ocean Optics, Inc.
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The Absorbance Spectrum of Chlorophyll

The mixture of two chlorophyll molecules (chlorophyll a and b) from green, leafy plants absorbs
several wavelengths of visible light, with five distinct absorbance peaks: three in the blue range
(413, 454, and 482 nm) and two yellows (631 and 669 nm). The combination of these
wavelengths is green to the human eye, but different ratios of these chlorophylls can create many
shades of green.

In this experiment you will extract chlorophyll from spinach (or some other fresh green leafy
specimen) and measure its absorbance spectrum. While you wait for the extract to develop, you
will measure the absorbance of blue and yellow food colored water samples which will provide
an analogy to the absorbance of the chlorophyll extract.

Materials

Ocean Optics or Vernier Spectrometer spinach or fresh green leaves
computer isopropanol or ethanol

SpectraSuite or Logger Pro 3 software yellow and blue food colored solutions
cuvettes three small beakers

one dark cuvette (filled with a solid) two 10 mL graduated cylinders

mortar and pestle ring stand and ring

funnel and filter paper plastic Beral pipettes

Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

Procedure A, Part One: The Absorbance of Food Coloring
Using SpectraSuite Software

1. Tear up a small sample of spinach into tiny pieces and grind them with a mortar
and pestle. Add 20-30 mL of 70% isopropanol (IPA) and transfer the mixture to a
small beaker. Allow the mixture to sit for 30 minutes.

Set up an apparatus to filter the IPA/chlorophyll extract into a clean beaker.
3. Obtain small amounts of blue and yellow food colored solutions.

Use a USB cable to connect a spectrometer to your computer. Start the
SpectraSuite software.

5. On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the
spectrometer to warm up for at least five minutes before proceeding.

6. Fill a cuvette ~%; full with distilled water to serve as a blank.

© 2007 Ocean Optics, Inc. 23
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7. Calibrate the spectrometer and measure the absorbance of the food colored solutions.

a.

Open the File menu and choose New — Absorbance Measurement. The “Set
Acquisition Parameters wizard” will appear. This process has four steps. First,
confirm that your spectrometer has been identified, and then click etz |

Place the blank cuvette in the spectrometer. In step two of this process, make sure
that the box next to “Strobe/Lamp Enable” is checked. Manually select a
suitable integration time by using the arrow keys to increase or decrease the
integration time, in milliseconds. Click _™** |to proceed.

To record the absorbance spectrum of the blank (100% transmittance), click the
Store Reference Spectrum icon, «. Click _tet> |t proceed.

Remove the blank cuvette and place the dark cuvette in the spectrometer. To save
the dark reference (0% transmittance), click the Store Dark Spectrum icon, ¥.
Pour out the water from the blank cuvette, rinse, and fill it ~% full with the blue
food colored solution. Place the cuvette in the spectrometer. Click L_f="_] to
complete the acquisition parameters wizard.

A plot of absorbance vs. wavelength for the blue liquid is displayed. Note the
toolbar across the top of the graph; you will use some of the options in this
toolbar throughout the experiment.

8. To save the plot of the blue food coloring sample, follow these steps:

a.

b.
c.
d

Click = to save the absorbance spectrum.

In the Filename box, type in a name for your set of data.

Click [_#=#¢._ Type in the name again and click [ 5= ],

In the Save Spectrum dialog box, click | 5 | and then click L2 . Your file
will be saved in the default folder named “bin”.

9. Pour out the blue solution from the cuvette, rinse, and fill it ~% full with the yellow food
colored solution. Place the cuvette in the spectrometer.

10. Note that the absorbance plot for the yellow solution is displayed. Repeat Step 8 to save

the plot.

11. Mix equal amounts of the blue and yellow solutions into a small beaker. Pour out the
yellow solution from the cuvette, rinse, and fill it ~% full with the mixture. Place the
cuvette in the spectrometer.

12. Repeat Step 8 to save the absorbance vs. wavelength plot for the mixture.

13. To prepare a graph of any of the three plots, follow these steps:

a.
b.

Open the File menu and choose Open — Load Processed Spectrum.
The default “bin” folder will appear. Select a file and click || This will
open the file, but not display the data on the graph yet.

Click = (Overlay Spectral Data). In the Load Spectrum dialog box, click on the
first file listed (it will be designated as “Processed”).

Click |-*#=%_]| Your selected file will be plotted on the graph.
Repeat Steps a-d until you have the desired plots on your graph.

Procedure A, Part Two: The Absorbance of Chlorophyll

14. After the IPA/chlorophyll extract has been soaking for 30 minutes, filter the extract into a
clean beaker.

15. Measure the absorbance spectrum of the chlorophyll extract.

24
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a. Open the File menu and choose New — Absorbance Measurement. You need
to calibrate the spectrometer again because your solvent in the chlorophyll
extract is not water, it’s IPA.

b. Click _**> |to confirm your spectrometer. Make sure that the Strobe/Enable
box is checked, and then Click etz |

c. Prepare an IPA blank cuvette and place it in the spectrometer. Click the Store
Reference Spectrum icon, «. Click LMet> 1o proceed.

d. Remove the blank cuvette and place the dark cuvette in the spectrometer. Click
the Store Dark Spectrum icon, ¥.

e. Pour out the IPA from the blank cuvette, rinse, and fill it ~% full with the
continue.

f. A plot of absorbance vs. wavelength for the chlorophyll is displayed.

g. Inthe Choose Target dialog box, select Show Data in New Graph.

h. Click L= | o see the graph of your chlorophyll spectrum.
16. To close the SpectraSuite program, select File — Exit, and then click Lres |

Procedure B, Part One: The Absorbance of Food Coloring
Using Logger Pro 3 Software

1. Tear up a small sample of spinach into tiny pieces and grind them with a mortar and
pestle. Add 20-30 mL of 70% isopropanol (IPA) and transfer the mixture to a small
beaker. Allow the mixture to sit for 30 minutes.

Set up an apparatus to filter the [PA/chlorophyll extract into a clean beaker.
Obtain small amounts of blue and yellow food colored solutions.

Fill a cuvette ~% full with distilled water to serve as your blank.

wokh W

Use a USB cable to connect a spectrometer to your computer. Start the Logger Pro 3.5
software. Allow the spectrometer to warm up for a few minutes.

6. Calibrate the spectrometer.

a. Open the Experiment menu and select Calibrate — (Spectrometer). The
following message appears in the Calibrate dialog box: “Waiting ... seconds for
the device to warm up.” After 60 seconds, the message changes to: “Warmup
complete.”

b. Place the blank in the cuvette holder of the spectrometer. Align the cuvette so
that the clear sides are facing the light source of the spectrometer. Click “Finish

Calibration”, and then click| ok |

7. Conduct a full spectrum analysis of a food dye sample.
a. Rinse and fill the cuvette % full with the blue food dye solution and place the
cuvette in the spectrometer.
b. Click [»coltect]. A full spectrum graph of the food dye sample is displayed.
c. Examine the graph, noting the peak or peaks of very high absorbance or other
distinguishing features.
d. To save the data, select Experiment — Store Latest Run.

8. Repeat Step 7 to measure the absorbance spectrum of the yellow food dye sample.
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9. Mix equal amounts of the blue and yellow solutions into a small beaker. Rinse and fill the
cuvette ~% full with the mixture. Place the cuvette in the spectrometer.

10. Repeat Step 7 to measure the absorbance spectrum for the mixture.

11. To prepare a graph of any of the three plots, follow these steps:

a. Place your cursor anywhere on the graph and double click.

b. In the Graph Options dialog box, select the Axes Options tab at the top left of
the dialog box.

c. Place a check next to the absorbance box for any of the three plots that you wish
to place on the graph.

d. Click to close the dialog box.

e. To save your data as a file, open the File menu and select Save As.... Name the
file and save it to the desktop of your computer.

Procedure B, Part Two: The Absorbance of Chlorophyll

1. After the IPA/chlorophyll extract has been soaking for 30 minutes, filter the extract into a
clean beaker.

2. Measure the absorbance spectrum of the chlorophyll extract.

a. Open the File menu and select New. You need to calibrate the spectrometer again
because your solvent in the chlorophyll extract is not water, it’s IPA.

b. Open the Experiment menu and select Calibrate — (Spectrometer).

c. Prepare an IPA blank and place it in the spectrometer. After one minute has
passed, click “Finish Calibration”, and then click| ok |

d. Pour out the IPA from the blank cuvette, rinse, and fill it ~%5 full with the
chlorophyll extract. Place the cuvette in the spectrometer. Click to see a
plot of the absorbance spectrum for the chlorophyll extract.

3. Examine the graph, noting the absorbance peaks for chlorophyll a and b described in the
introductory remarks.

4. To save your data as a file, open the File menu and select Save As.... Name the file and
save it to the desktop of your computer.

5. To close Logger Pro 3.5, open the File menu and select Exit.
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Data and Questions

1. Consult a reliable resource to identify the major absorbance peaks of chlorophyll a and
chlorophyll b. Examine the absorbance vs. wavelength graph for chlorophyll. Does your
graph clearly show these absorbance peaks? Are there other, undefined, peaks on your
graph? Identify them and speculate about what caused these peaks.

2. How did your tests of the absorbance of the blue and yellow food colored solutions
compare with the tests of the chlorophyll extract?

3. [If distilled water had been used as the calibration blank for the chlorophyll test, would it
have affected the absorbance measurements?

4. Were the distinguishing features of chlorophyll a and b evident in the absorbance
spectrum graph of the chlorophyll extract? Explain.
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Determining the Rate Law of a Chemical
Reaction

The primary objective of this experiment is to determine the rate law and order of a reaction
between solutions of crystal violet and sodium hydroxide. When there is more than one reactant,
as in this case, the isolation method is often used which entails making the concentration of all
but one of the reactants very high. In so doing, the concentration of only one reactant will change
appreciably during the reaction. The order with respect to the isolated reactant is then determined.
The process is repeated, isolating each of the other reactants in turn, until the order of all reacting
species has been determined.

In this experiment, you will use a vast excess of the sodium hydroxide solution. Thus, the rate and
order of the reaction will be in crystal violet only. We will define the rate of the reaction as the
disappearance of crystal violet over time, which can be expressed in differential form as d[CV] /
dt.

You will measure the absorbance of the reaction over time, at a specific wavelength of visible
light. You will first measure the absorbance spectrum of a crystal violet solution and select one
wavelength to examine during the reaction. As the reaction proceeds, the bright purple color of
the crystal violet solution will fade and the absorbance will decrease.

The order with respect to crystal violet (CV) can be determined by graphically applying the
integrated rate laws. According to Beer’s law, the absorbance of a CV solution is directly
proportional to the concentration of CV. Thus, the actual [CV] can be replaced by A, the
maximum absorbance of the CV solution. A graph of A« as a function of time will give a
straight line if the reaction is zero order in CV. If the reaction is first order in CV, then a graph of
In(Ap.x) as a function of time is linear. Finally, for the purposes of this experiment, if the reaction
is second order, then a graph of 1/A,,.« as a function of time is linear. In each case, the slope of
the best-fit line equation for the graph is equal to the rate law constant, £. When you analyze your
test results, you will choose which of the three plots described above represents the best linear
function.

Materials

Ocean Optics or Vernier Spectrometer 1.0 x 107" M crystal violet solution
Computer 0.05 M NaOH solution

SpectraSuite or Logger Pro 3 software two 10 mL graduated cylinders or pipettes
Cuvettes three small beakers

one dark cuvette (filled with a solid) plastic Beral pipettes

Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.
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Procedure A: Using Ocean Optics SpectraSuite Software

30

Obtain 15-20 mL of the crystal violet and sodium hydroxide solutions.

Fill a cuvette ~%4 full with the 0.05 M NaOH solution to serve as a blank. Measure out 10
mL of both solutions into separate beakers.

Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite
software.

Calibrate the spectrometer and set up the data collection for the experiment.

a.  On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the
spectrometer to warm up for at least five minutes before proceeding.

b. Place the blank cuvette in the spectrometer. On the left hand side of the toolbar,
manually increase or decrease the integration time so that the peak absorbance is
slightly above 50,000 counts.

c. Record the absorbance spectrum of the blank (100% transmittance), by clicking
the Store Reference Spectrum icon, - (the yellow light bulb just above the
graph).

d. Remove the blank cuvette and place the dark cuvette in the spectrometer. Save

the dark reference (0% transmittance), by clicking the Store Dark Spectrum icon,
¥ (the gray light bulb above the graph).

Click the Absorbance mode icon, A

Open the File menu and select New — Strip Chart.

In the Chart Trend Settings dialog box, check the box next to Stop after this
amount of time and change the time to 10 minutes.

On the right side of the dialog box under Range Selection select One

Wavelength and select 585 nm.

Fo@moe

To prepare for the reaction, pour out the NaOH solution from the blank cuvette and rinse
the cuvette with distilled water.

Mix the 10 mL of NaOH and CV solutions in a third beaker. Swirl the beaker gently, and
then use a plastic Beral pipette to transfer 2-3 mL of the reaction mixture to the cuvette.

Place the cuvette in the spectrometer. Click |22 ] A graph of absorbance vs. time will
be displayed. If the Strip Chart Options dialog box appears, use your mouse to move it
aside during the data collection.

After the run ends, export the emission measurements to Microsoft Excel.

i.  Click the Copy Spectral Data to Clipboard icon, ,on the toolbar.
j. Open Excel.

k. In Excel, open the Edit menu and choose Office Clipboard...

1. Click the spectral data file on the clipboard.

To store your data, click Save, & In the Save Trend dialog box, highlight the trend and
click the Browse button, L#*=-- | Choose a location for the file, name it, and then click
the Save button, [_== . Back on the Save Trend dialog box, click (== |, Click L.2%=_]
to continue.

10. To close the SpectraSuite program, select File — Exit, and then click [,
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Procedure B: Using Vernier Logger Pro 3 Software

Obtain 15-20 mL of the crystal violet and sodium hydroxide solutions.

2. Fill a cuvette ~%5 full with the 0.05 M NaOH solution to serve as a blank. Measure out 10
mL of both solutions into separate beakers.

3. Use a USB cable to connect a spectrometer to your computer. Start the
Logger Pro 3 software.

4. Calibrate the spectrometer and set up the data collection for the experiment.

a. Open the Experiment menu and choose Calibrate — (Spectrometer). There is
a 60 second warm up, but you may allow the spectrometer to warm up for a
longer period of time if desired.

b. After the spectrometer is warmed up, place the blank cuvette in the spectrometer.
Click “Finish Calibration”, and then click| ok |,

c. Click the Configure Spectrometer Data Collection icon, ), on the toolbar. In the
Configure Spectrometer dialog box, select Abs vs. Time under Set Collection
Mode.

d. Click the Clear button, M, at the bottom of the dialog box. Scroll down the
Select Wavelength column and check the box next to 586 nm. Click[ ok |,

e. Open the Experiment menu and choose Data Collection... Change the length of
time to 10 minutes and change the sampling rate to

60 samples/minute. Click [ Done |,

5. To prepare for the reaction, pour out the NaOH solution from the blank cuvette and rinse
the cuvette with distilled water.

6. Mix the 10 mL of NaOH and CV solutions in a third beaker. Swirl the beaker gently, and
then use a plastic Beral pipette to transfer 2-3 mL of the reaction mixture to the cuvette.

7. Place the cuvette in the spectrometer. Click [» collect]. A graph of absorbance vs. time will
be displayed. The data collection will run for ten minutes, or you can click | m stop |to halt
the run early.

8. At the conclusion of the run, examine the graph of absorbance vs. time, showing a
gradual decrease in absorbance. To save your graph, open the Experiment menu and
select Store Latest Run.

9. Complete the Data Analysis section before exiting Logger Pro 3.

10. (Optional) Open the File menu and select Save As... to save your experiment file.
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Data Analysis
1. Prepare three plots: absorbance vs. time, In abs vs. time, and 1/abs vs. time. Calculate the
best-fit line equation for the plot that is the most linear, and write down the equation.
2. Based on the information provided in the introductory remarks, what is the order of the
reaction with respect to crystal violet?
3. Based on the information provided in the introductory remarks, write the rate law for this
reaction.

Extension

In some instances it is not possible to isolate a reactant because the concentration of the reactant
must remain high for the reaction to behave predictably. This is the case with the reaction
between crystal violet and sodium hydroxide; the [OH™] must remain high. However, the order of
the reaction with respect to OH™, and the subsequent rate law constant, can still be determined.

To determine the order of the reaction in OH", you must conduct the reaction using different
concentrations (albeit in vast excess) of OH". From each data collection run you will calculate a
value of k. Using the values of & and the [OH], you will prepare a plot of In [OH] (the Y-values)
vs. In k (the X-values). The best-fit line for this plot takes the form: In(k.,s) = m In[OH| + Ink.
The slope, m, is the order of the reaction in OH", and the Y-intercept is the natural logarithm of
the rate constant.
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Emission Spectra

A fascinating feature of spectroscopy is how one can make use of light to learn about atomic and
molecular structure. Under certain conditions, an atom or molecule will absorb or emit light. By
examining and measuring the light that is absorbed or emitted by a substance, certain physical
properties are revealed.

The electrons of atoms and molecules exist in specific energy states. The energy emitted by the
excitation of electrons is limited to differences between these states, thus specific energies of light
are emitted. The color of a glowing LED, for example, is a result of the energy of the emitted
light. The energy and wavelength of the light is described by the equation E = hc/A, where A is the
wavelength, h is Planck's constant (6.63 x 107* J sec), and c is the speed of light (3.00 x 10°
m/sec). If you are measuring the emission spectrum of a gas trapped in a discharge tube, only
certain wavelengths of light are emitted by the gas and the “pattern” that is produced is unique for
that substance.

In this experiment you will use the spectrometer outfitted with a fiber optic cable to measure the
emissions spectra of various sources of light.

Materials

Ocean Optics or Vernier Spectrometer light sources:
without the light source/cuvette holder LEDs, lamps

fiber optic cable discharge tubes

SpectraSuite or Logger Pro 3 software lamps

Procedure A: Using Ocean Optics SpectraSuite Software

1. Use a USB cable to connect an Ocean Optics or Vernier spectrometer to your computer.
Make sure that the light source/cuvette holder has been detached from the spectrometer.
Connect a fiber optic cable to the threaded detector housing of the spectrometer.

Start the SpectraSuite program.

3. Turn on the light source. Aim the tip of the fiber optic cable at the light source.

There are two methods of optimizing the graph of intensity vs. wavelength. Depending on
the light source you are measuring, one method may be better.

a. Set the distance between the light source and the tip of the fiber optic cable so
that the peak intensity on the graph is ~3500 counts.

b. Adjust the Integration Time, which is located in the upper left hand portion of
the SpectraSuite window. If the peak absorbance is off scale, reduce the
integration time. If the peaks are too small, increase the integration time.
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When you are satisfied with your emission graph, click save, & In the Save Spectrum
dialog box, click the Browse button, L& | Choose a location for the file, name it, and
then click the Save button, |_==_|. Back on the Save Spectrum dialog box, click |_== |
Click L= to continue.

To view the emission spectrum graph:

a. Click the Overlay Spectral Data icon, g, on the right of the toolbar.

b. Choose the file you saved in Step 5, and then click the Open icon, ||,

c. Inthe Load Spectrum dialog box, choose your file (which will be coded as
“Processed”), and then click the Load icon, [ == |,

To analyze your emission spectrum graph:

a. Click anywhere on the graph to activate the cursor. Note the green vertical line
marking a given wavelength on the graph; a box below the graph identifies the
wavelength.

b. Click on the peak, or peaks, of the emission spectrum. A legend below right of
the graph displays the counts at a specified wavelength. Write down the peak or
peaks, as well as other distinguishing characteristics of the graph, in your lab
book.

Repeat Steps 4-6 to plot and capture the emission spectrum of a second light source. By
using the Overlay Spectral Data option, you can plot more than on emission spectrum
on the same graph. If you wish to remove a set of graphed data, click the Delete Overlay

Spectra icon, @ Choose the plot you want deleted (all of the plots are color-coded) and
click L= | After you have deleted the desired plot or plots, click L= |,

To export the graphed emission measurements to Microsoft Excel:
c. Click the Copy Spectral Data to Clipboard icon, ,on the toolbar.
d. Open Excel.

e. In Excel, open the Edit menu and choose Office Clipboard...
f.  Click the spectral data file on the clipboard.

10. To close the SpectraSuite program, select File — Exit, and then click [,

Procedure B: Using Vernier Logger Pro 3 Software

1.

34

Use a USB cable to connect an Ocean Optics or a Vernier Spectrometer to your
computer. Make sure that the light source/cuvette holder has been detached from the
spectrometer. Connect a fiber optic cable to the threaded detector housing of the
spectrometer.

Start the Logger Pro 3 program.

Turn on the light source. Aim the tip of the fiber optic cable at the light source.

To prepare Logger Pro 3 to measure light emission, open the Experiment menu and
choose Change Units — Spectrometer — Intensity.

Click | » collect | An emission spectrum will be graphed. There are two methods of
optimizing the graph of intensity vs. wavelength. Depending on the light source you are
measuring, one method may be better.

a. Set the distance between the light source and the tip of the fiber optic cable so
that the peak intensity on the graph stays below 1.0.
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b. Open the Experiment menu and choose Set Up Sensors — Show All Interfaces.
In the Spectrometer dialog box, increase or decrease the Sample Time to
optimize your plot.

6. When you have a suitable emissions plot, click | ® stop |. To analyze your emission
spectrum graph click the Examine icon, [, on the toolbar. Scroll across the emission plot
to identify the peak or peaks. Write down the distinguishing characteristics of the graph
in your lab book.

7. Store the emission data by opening the Experiment menu and choosing Store Latest

Run.

(Optional) Repeat Steps 5 — 7 to measure the emission spectrum of a second light source.

9. To export the emission measurements to Microsoft Excel:

@

a. Click once anywhere on the table to activate it.

b. Open the Edit menu and choose Select All (shortcut: Ctrl A). If you don’t want
to export all of the data, highlight the individual columns rather than choosing
Select All.

¢. Open the Edit menu again and choose Copy (shortcut: Ctrl C).

d. Open Excel. In Excel, open the Edit menu and choose Paste
(shortcut: Ctrl V).

10. (Optional) To save your experiment file open the File menu and select Save As.... Name
the file and save it to a convenient location in your computer.

11. To close the Logger Pro 3 program, select File — Exit, and follow the onscreen prompt
if you haven’t saved your data to a named file.
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Data Analysis

1. Examine your first graph of emission. Identify the peak or peaks. Describe the
distinguishing characteristics of the graph.

2. Examine your second graph of emission. As before, identify the peak or peaks and
describe the distinguishing characteristics of the graph.

3. Are there any features of either graph that stand out as being unusual or unexpected?

4. Below are two emission graphs. The graph on the left is the emission from standard
fluorescent office lighting. The graph on the right is the emission from a mercury
discharge tube. Using these graphs, make a case either for or against the presence of
mercury in the office lighting. The X- and Y-axis ranges for the graphs are identical.

Flusissoint CHfice Lighes ISty

-,upqw\; Ul
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Determining the Nitrate Concentration In
Natural Waters

A common part of water analysis is measuring the nitrate, NOs~, concentration. Freshwater nitrate
levels are normally about 1 mg/L or less, but animal feedlots, agricultural field runoff, and treated
municipal waste can increase the nitrate concentration. High nitrate levels in natural waters
contribute to the abnormal proliferation of plant life in and around the waters, a condition known
as eutrophication. Agricultural areas are especially vulnerable to this problem.

Humans stand to become ill if they drink water with nitrate levels above 10 mg/L, and it is
potentially fatal to the very young (causing the disease methemoglobinemia). Given the insidious
name Blue-Baby Syndrome, this condition is characterized by nitrates interfering with
hemoglobin’s ability to transport oxygen.

In this experiment, you will use a spectrometer to measure the absorbance of several standard
nitrate solutions. You will calculate the best-fit line function for the standard solutions, and use
this information to determine the molar concentration of water samples from natural sources.

Materials

Ocean Optics or Vernier Spectrometer commercial test reagents for nitrates
Computer water samples from several sources
SpectraSuite or Logger Pro 3 software distilled water

Cuvettes 5.0 mg/L nitrate standard solution
One dark cuvette (filled with a solid) 10 mL graduated cylinders or pipettes
Six 25 mL or 50 mL Erlenmeyer flasks plastic Beral pipettes

Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

© 2007 Ocean Optics, Inc. 37
Vernier Software & Technology



Spectroscopy 101

Procedure A: Using Ocean Optics SpectraSuite Software

1. Label five flasks for your standard solutions. Prepare the nitrate standards according to
the chart below.

mL of mL of _
Flask 5.0 mg/L distilled | NOs Conc.

NO;~ water (mg/L)

1 10.0 0.0 5.0

2 8.0 2.0 4.0

3 6.0 4.0 3.0

4 4.0 6.0 2.0

5 2.0 8.0 1.0

2. Prepare the nitrate standards according to the directions for the reagent kit that you are
using. The most common, Hach and LaMotte, have slightly different procedures for
prepping the standard samples.

3. Obtain small amounts of the water samples to be tested in Step 9.

Fill a cuvette ~% full with distilled water to serve as your blank.

5. Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite
software.

6. Calibrate the spectrometer.

a.

b.

g.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the
spectrometer to warm up for at least five minutes before proceeding.

Place the blank cuvette in the spectrometer. Open the File menu and choose New
— Absorbance Measurement. The “Set Acquisition Parameters wizard” will
appear. This process has four steps. First, confirm that your spectrometer has
been identified, and then click etz |

In step two of this process, make sure that the box next to “Strobe/Lamp
Enable” is checked. Manually select a suitable integration time by using the
arrow keys to increase or decrease the integration time, in milliseconds. Click
Met> |1 proceed.

To record the absorbance spectrum of the blank (100% transmittance), click the
Store Reference Spectrum icon, - . Click etz o proceed.

Remove the blank cuvette and place the dark cuvette in the spectrometer. To save
the dark reference (0% transmittance), click the Store Dark Spectrum icon, ¥.
Pour out the distilled water from the blank cuvette, rinse, and fill it with the 5.0
mg/L standard solution in flask #1. Place the cuvette in the spectrometer. Click
Lesh o complete the acquisition parameters wizard.

A plot of absorbance vs. wavelength for the nitrate standard is displayed.

7. Important: Examine the graph and select the peak wavelength that you wish to use for
your standards.

38
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8. Set up the data collection for the nitrate standards.

a.

b.

Open the File menu and choose New — New Concentration Measurement.

Select “Active Processing:”, and then click |t |,
The Concentration Measurement Setup wizard appears, and its default is the
Beer-Lambert Law. Select “Calibrate from solutions of known
concentration”. Click _"*>_|
The Range Selection defaults to a single wavelength. Enter the peak wavelength
that you identified in Step 6, and then click | Met> |
The next dialog box sets up the Beer’s law graph of your standard solutions.
Type in the concentration of your first sample, 5.0. Click Iml, and then
click _##s | The absorbance of your first standard is saved and plotted on the
small graph in the dialog box.
Remove the cuvette and dispose of the solution as directed. Rinse and fill the
cuvette with the nitrate standard solution in flask #2. Place the cuvette in the
spectrometer. Type in the concentration, click Iml, and then click

Add Sample |

Repeat step e for the remaining standards. When you complete the final standard
solution (1.0 mg/L), type in the compound name and unit of concentration
(mg/L). A best-fit line will be calculated for your standards. Make sure the
regression order is set to 1. Note: To delete a data point, choose a row of data

and click . Click L_f="_] to continue.

9. To measure the absorbance and determine the NO;™ concentration of the water samples:

a.
b.

C.

Rinse and fill the cuvette ~% full with the first water sample.

Click Single Update and write down the nitrate concentration of the water
sample.

Repeat Steps a & b above for the remaining water samples.

10. To close the SpectraSuite program, select File — Exit, and then click (e ],
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Procedure B: Using Vernier Logger Pro 3 Software

1. Label five flasks for your standard solutions. Prepare the nitrate standards according to
the chart below.

5.0 mg/L NO;~ distilled water NO;™ Conc.
Flask (mL) (mL) (mg/L)
1 10.0 0.0 5.0
2 8.0 2.0 4.0
3 6.0 4.0 3.0
4 4.0 6.0 2.0
5 2.0 8.0 1.0

2. Prepare the nitrate standards according to the directions for the reagent kit that you are
using. The most common, Hach and LaMotte, have slightly different procedures for
prepping the standard samples.

3. Obtain small amounts of the water samples to be tested in Step 9.
Fill a cuvette ~% full with distilled water to serve as your blank.

5. Use a USB cable to connect a spectrometer to your computer. Start the
Logger Pro 3 software. Allow the spectrometer to warm up for five minutes.

6. Calibrate the spectrometer.

a. Open the Experiment menu and select Calibrate — (Spectrometer). The
following message appears in the Calibrate dialog box: “Waiting ... seconds for
the device to warm up.” After 60 seconds, the message changes to: “Warmup
complete.”

b. Place the blank in the cuvette holder of the spectrometer. Align the cuvette so
that the clear sides are facing the light source of the spectrometer. Click “Finish

Calibration”, and then click| ok |,

7. Determine the maximum wavelength for the nitrate standards and set up the data
collection mode.

a. Pour out the distilled water from the blank cuvette, rinse, rinse and fill it with the
5.0 mg/L nitrate standard solution in flask #1. Place the cuvette in the
spectrometer.

b. Click [» coltect|. A full spectrum graph of the nitrate standard solution will be
displayed. Note that one area of the graph contains a peak absorbance. Click

W stop |to complete the analysis.

c. (Optional) To save your graph of absorbance vs. wavelength, choose
Experiment — Store Latest Run.

d. Click the Configure Spectrometer Data Collection icon, i}, on the toolbar.

e. Select Absorbance vs. Concentration under Set Collection Mode. The peak
absorbance will be automatically selected. (Optional: to select a new wavelength,
click on the graph or check the box next to the desired wavelength. To start over,
click % _|and select a wavelength, or wavelengths again.) Click to
proceed.

8. Collect absorbance-concentration data for the five standard solutions.
a. Click [» collect]. When the absorbance reading stabilizes, click [@ keep |. Enter “5.0”
as the concentration of the solution and click| ok |,
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b. Remove the cuvette and dispose of the solution as directed. Rinse and fill the
cuvette with the nitrate standard solution in flask #2. Place the cuvette in the
spectrometer. When the absorbance reading stabilizes, click | keep |. Enter “4.0”
as the concentration.

c. Repeat Step 7b for the remaining standard solutions. When you have finished

testing the standards, click [ m stop |.

9. To determine the best-fit line equation for the CoCl, standard solutions, click the linear
fit button, [, on the toolbar. Write down the equation for the standard solutions in your
lab book.

10. To measure the absorbance and determine the NO;™ concentration of the water samples:

a. Rinse the cuvette twice with a water sample and fill it about % full. Wipe the
outside of the cuvette and place it in the spectrometer.

b. Open the Analyze menu and choose Interpolation Calculator. A dialog box
will appear that displays the concentration of your water sample at the selected
absorbance.

c. Click| ok | Write down the concentration of the water sample in your lab
book.

d. Repeat Steps a — ¢ above for the remaining water samples.

11. (Optional) To save your experiment file open the File menu and select Save As.... Name
the file and save it to a convenient location in your computer.

12. To close the Logger Pro 3 program, select File — Exit, and follow the onscreen prompt
if you haven’t saved your data to a named file.
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Data
NO;™ Conc.
Flask (13ng /Sl ¢ Absorbance

1 5.0

2 4.0

3 3.0

4 2.0

5 1.0
Questions
1. What wavelength did you use to measure the absorbance of the nitrate standard solutions

and the water samples?

2. What was the best-fit line equation for the nitrate standard solutions?
3. What were the nitrate concentrations of the water samples that you tested?

Samples of water from streams and lakes are notoriously impure. Some of these
impurities can affect a test of this type. Suggest ways to make sure that other substances
in a water sample do not interfere with a spectrophotometric test for nitrates.
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Spectrophotometric Determination of an
Equilibrium Constant

In this experiment, you will study the reaction between aqueous solutions of iron (III) nitrate,
Fe(NOs);, and potassium thiocyanate, KSCN. The reaction produces the blood-red complex
FeSCN?". The reaction also establishes an equilibrium, as shown below.

Fe’* (aq) + SCN™ (aq) <> FeSCN*" (aq)
The equilibrium constant, K.y, may be expressed as:

. - Fesovi)
‘ [Fe*™ ][SCN™]

You will prepare five standard solutions with known concentrations of FeSCN** (aq), and then

you will measure and record the absorbance of each standard at 447 nm. You will use the plot of

absorbance vs. concentration to construct a calibration graph for [FeSCN*"].

In the second part of the experiment, you will mix various concentrations of Fe(NOs); and KSCN
and measure the absorbance of the mixture to determine the [FeSCN*']. From the original
amounts of reactants for each trial, and the amount of product formed, you will calculate the
molar concentration of all the species in the equilibrium. Based on the results of your testing you
will calculate a value for the equilibrium constant, K.

Materials

Ocean Optics or Vernier Spectrometer 0.00200 M KSCN solution
Computer 0.00200 M Fe(NOs); solution
SpectraSuite or Logger Pro 3 software 0.200 M Fe(NOs); solution
Cuvettes 0.05 M HNOs solution

one dark cuvette (filled with a solid) 50 mL beakers

10 mL graduated cylinders or pipettes plastic Beral pipettes
Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the 0.05 M HNO; solution.

Pre-Lab Exercise

The chart below provides the volumes of reactants needed to prepare the standard solutions.
Notice that the concentration of the Fe(NOs); solution is much greater than that of the KSCN
solution, which ensures that all of the SCN™ ions are used up in the reaction. The concentration of
the product will be determined from the volume and concentration of the KSCN used in each
trial. Calculate the molar concentration of FeSCN*" for each of the mixtures and write down these
values in the chart.

Prepare each mixture in a separate 50 mL beaker.
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Equilibrium Standards Mixing Chart

Beaker | OpoaotM |0 jﬂ%!‘;'g °|_'|?150"3" [FeSCN?]
1 5.0 mL 5.0 mL 15.0 mL
2 4.0 mL 5.0 mL 16.0 mL
3 3.0mL 5.0 mL 17.0 mL
4 2.0mL 5.0 mL 18.0 mL
5 1.0 mL 5.0 mL 19.0 mL

Procedure A, Part One: Equilibrium Standards
Using Ocean Optics SpectraSuite Software

Fill a cuvette ~% full with 0.05 M HNO; solution to serve as the blank.

2. Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite
software.

3. Calibrate the spectrometer.

a.

b.

f.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the
spectrometer to warm up for at least five minutes before proceeding.

Place the blank cuvette in the spectrometer. Open the File menu and choose New
— Absorbance Measurement. The “Set Acquisition Parameters wizard” will
appear. This process has four steps. First, confirm that your spectrometer has
been identified, and then click _f=> |

In step two of this process, make sure that the box next to “Strobe/Lamp
Enable” is checked. Manually select a suitable integration time by using the
arrow keys to increase or decrease the integration time, in milliseconds. Click
etz g0 proceed.

To record the absorbance spectrum of the blank (100% T), click the Store
Reference Spectrum icon, «. Click LMet> |10 proceed.

Remove the blank cuvette and place the dark cuvette in the spectrometer. To save
to complete the acquisition parameters wizard.

Dispose of the 0.05 M HNO; solution in the cuvette as directed.

4. Set up the data collection.

a.
b.
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Rinse and fill the cuvette ~% full with the mixture in beaker #1.

Open the File menu and choose New — New Concentration Measurement.
Select “Active Processing:”, and then click et |

The Concentration Measurement Setup wizard appears, and its default is the
Beer-Lambert Law. Select “Calibrate from solutions of known
concentration”. Click _"#> |

The Range Selection defaults to a single wavelength. Enter 447, and then
click _tet> |
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The next dialog box sets up the Beer’s law graph of your standard solutions.
Type in the [FeSCN**] that you calculated for the mixture in beaker #1. Click
Iml, and then click _##5#% | The absorbance of your first standard is
saved and plotted on the small graph.

Remove the cuvette and dispose of the mixture as directed. Rinse and fill the
cuvette with the mixture in beaker #2. Place the cuvette in the spectrometer. Type
in the [FeSCN*'7, click #2552 | anq then click _ A5 |,

Repeat step f for the remaining standards. When you complete the final standard
solution, type in the compound name and unit of concentration (mol/L). A best-
fit line will be calculated for your standards. Make sure the regression order is set

to 1. Note: To delete a data point, choose a row of data and click .
Click "] to continue.

Procedure A, Part Two: Testing Equilibrium Systems

Prepare five new mixtures according to the mixing chart below. Note that this set of combinations
uses a more dilute solution of Fe(NO3)s.

Equilibrium Systems Mixing Chart

Beaker | VWM [ OUEOW [ GOSM | ooy
A 5.0 mL 1.0 mL 4.0 mL
B 5.0 mL 2.0mL 3.0mL
C 5.0 mL 3.0 mL 2.0mL
D 5.0 mL 4.0 mL 1.0 mL
E 5.0 mL 5.0 mL 0.0 mL

1. To measure the absorbance of the five equilibrium systems:

a.

Rinse and fill the cuvette ~%; full with the mixture in beaker A.

b. Click Single Update and write down the [FeSCN*'] in the chart above.

C.

Repeat Steps a & b above for beakers B — E.

2. To close the SpectraSuite program, select File — Exit, and then click [ves ]
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Procedure B, Part One: Equilibrium Standards
Using Vernier Logger Pro 3 Software

Fill a cuvette ~% full with 0.05 M HNO; solution to serve as the blank.

2. Use a USB cable to connect a spectrometer to your computer. Start the
Logger Pro 3 software. Allow the spectrometer to warm up for five minutes.

3. Calibrate the spectrometer.

a.

Open the Experiment menu and select Calibrate — (Spectrometer). The
following message appears in the Calibrate dialog box: “Waiting ... seconds for
the device to warm up.” After 60 seconds, the message changes to: “Warmup
complete.”

Place the blank in the cuvette holder of the spectrometer. Align the cuvette so
that the clear sides are facing the light source of the spectrometer. Click “Finish

Calibration”, and then click| ok |

4. Set up the data collection.

a.
b.
C.

Rinse and fill the cuvette ~%; full with the mixture in beaker #1.

Click the Configure Spectrometer Data Collection icon, i), on the toolbar.
Select Absorbance vs. Concentration under Set Collection Mode. Click %= |
at the bottom right of the dialog box. In the wavelength column, check the box

next to 447 nm. Click to proceed.

5. Collect absorbance-concentration data for the five standard solutions.

a.

b.

€.
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Click |» collect | When the absorbance reading stabilizes, click |® keep |. Enter the
[FeSCN?"] that you calculated for beaker #1. Click| ok |,

Remove the cuvette and dispose of the solution as directed. Rinse and fill the
cuvette with the nitrate standard solution in beaker #2. Place the cuvette in the
spectrometer. When the absorbance reading stabilizes, click | keep |. Enter the
[FeSCN*] for beaker #2, and then click[ ok _|.

Repeat Step 5b for the mixtures in beakers 3 — 5. When you have finished testing
the standards, click [ m stop |.

To determine the best-fit line equation for the [FeSCN?"] standard solutions, click
the linear fit button, [, on the toolbar.

Leave the graph in place and proceed to Part Two of the experiment.
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Procedure B, Part Two: Testing Equilibrium Systems
Prepare five new mixtures according to the mixing chart below. Note that this set of combinations

uses a more dilute solution of Fe(NO3)s.

Equilibrium Systems Mixing Chart

0.00200 M

0.00200 M

0.05 M

2+
Beaker KSCN Fe(NOs); HNO, [FeSCN*]
A 5.0 mL 1.0 mL 4.0 mL
B 5.0 mL 2.0 mL 3.0mL
C 5.0 mL 3.0 mL 2.0 mL
D 5.0 mL 4.0 mL 1.0 mL
E 5.0 mL 5.0 mL 0.0 mL

1. To measure the absorbance of the five equilibrium systems:

a. Rinse and fill the cuvette ~%5 full with the mixture in beaker A.

b. Open the Analyze menu and choose Interpolation Calculator. A dialog box will

appear that displays the concentration of your unknown at the measured
absorbance. Write down the absorbance and the [FeSCN?'] in the data table.

c. Repeat Steps a & b above for beakers B — E.

2. (Optional) To save your experiment file open the File menu and select Save As.... Name

the file and save it to a convenient location in your computer.

3. To close the Logger Pro 3 program, select File — Exit, and follow the onscreen prompt

if you haven’t saved your data to a named file.
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Data
Part One
Trial [SCN] [FeSCN*"] Absorbance
1
2
3
4
5
Part Two
Trial 1 2 3 4 5
Absorbance
[FeSCN?]

Volume Fe**

[Fe*] initial

[Fe*] final

Volume SCN™

[SCNT] initial

[SCNT] final

Data Analysis and Conclusions

1. For each of the trials in Part Two, use the equilibrium equation in the introductory
remarks to calculate the K.,. Report the best value of K for the reaction and explain how
you arrived at this number.

2. Describe the relationship between concentration and absorbance in Part One of the
experiment.

3. Describe why it was necessary for the [Fe’] to be a great deal larger than [SCN] in Part
One of the experiment.
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Spectroscopy 101

The Rydberg Constant

The light you see when you plug in a hydrogen gas discharge tube is a shade of lavender, with
some pinkish tint at a higher current. If you observe the light through a spectroscope, you can
identify four distinct lines of color in the visible light range. The history of the study of these
lines dates back to the late 19™ century, where we meet a high school mathematics teacher from
Basel, Switzerland, named Johann Balmer. Balmer created an equation describing the
wavelengths of the visible hydrogen emission lines. However, he did not support his equation
with a physical explanation. In a paper written in 1885, Balmer proposed that his equation could
be used to predict the entire spectrum of hydrogen, including the ultra-violet and the infrared
spectral lines. The Balmer equation is shown below.

2
2’:( ilm zj
m’—n

where m and n were integers, and & = 3654.6 % 10™* cm. When one solves the equation using n
=2 and m =3, 4, 5, or 6, the calculated wavelengths are very close to the four emission lines in
the visible light range for a hydrogen gas discharge tube. Balmer apparently derived his equation
by trail and error. Sadly, he would not live to see Niels Bohr and Johannes Rydberg prove the
validity of his equation.

Johannes Rydberg was a mathematics teacher like Balmer (he also taught a bit of physics). In
1890, Rydberg’s research of spectroscopy (inspired, it is said, by the work of Dmitri Mendeleev)
led to his discovery that Balmer’s equation was a specific case of a more general principle.
Rydberg substituted the wavenumber for wavelength, and applying appropriate constants, he
developed a variation of Balmer’s equation. The Rydberg constant bears witness to his
contribution to understanding the wave behavior of particles and helped paint a clearer picture of
emission spectra.

In 1913, Niels Bohr added to the description of the line spectra from the hydrogen discharge tube.
Bohr postulated that electrons orbited an atom in discrete energy levels. Along with Rydberg’s
work, Bohr called upon Max Planck’s investigation of black body radiation and Albert Einstein’s
determination of the energy of a photon. The combined thrust of these scientific heavyweights
resulted in “proving” Johan Balmer’s clever little formula. The Bohr equation takes the form

shown below.
[
A ny n

Niels Bohr used this equation to show that each line in the hydrogen spectrum corresponded to
the release of energy by an electron as it passed from a higher to a lower energy level. The energy
levels are the integers in the equation, labeled n; and n; for initial and final levels, with R,
representing the Rydberg constant. The term 1/A is the wavenumber, as expressed by Rydberg in
his version of the Balmer equation.

In this experiment you will measure the emission spectrum of hydrogen gas and analyze the
emission data to calculate the Rydberg constant.
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Materials
Ocean Optics or Vernier Spectrometer fiber optic accessory
computer hydrogen gas discharge tube

SpectraSuite or Logger Pro 3 software

Procedure A: Using Ocean Optics SpectraSuite Software

1.

W

Use a USB cable to connect an Ocean Optics or a Vernier Spectrometer to your
computer. Make sure that the light source/cuvette holder has been detached from the
spectrometer. Connect a fiber optic cable to the threaded detector housing of the
spectrometer.
Start the SpectraSuite program.
Turn on the hydrogen gas discharge tube. Aim the tip of the fiber optic cable at the tube.
There are two methods of optimizing the graph of intensity vs. wavelength. Use the
method that produces a better graph of the emission lines.
a. Set the distance between the light source and the tip of the fiber optic cable so
that the peak intensity on the graph is ~3500 counts.
b. Adjust the Integration Time, which is located in the upper left hand portion of
the SpectraSuite window. If the peak absorbance is off scale, reduce the
integration time. If the peaks are too small, increase the integration time.

When you are satisfied with your emissions graph, click save, & In the Save Spectrum
dialog box, click the Browse button, L&===- | Choose a location for the file, name it, and
then click the Save button, == |, Back on the Save Spectrum dialog box, click |_== |
Click 2= ] to continue.

To view the emission spectrum graph:

a. Click the Overlay Spectral Data icon, E, on the right of the toolbar.

b. Choose the file you saved in Step 5, and then click the Open icon, [ == |,

c. Inthe Load Spectrum dialog box, choose your file (which will be coded as
“Processed”), and then click the Load icon, == |,

To analyze your emission spectrum graph:

a. Click anywhere on the graph to activate the cursor. Note the green vertical line
marking a given wavelength on the graph; a box below the graph identifies the
wavelength.

b. Identify the four emission lines for hydrogen and write then down in the data
table.

NOTE: You will need to examine your graph of the hydrogen emissions to complete the Data
Analysis section of the experiment.

8.
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To close the SpectraSuite program, select File — Exit, and then click [,
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Procedure B: Using Vernier Logger Pro 3 Software

1.

W

Use a USB cable to connect an Ocean Optics or a Vernier Spectrometer to your
computer. Make sure that the light source/cuvette holder has been detached from the
spectrometer. Connect a fiber optic cable to the threaded detector housing of the
spectrometer.
Start the Logger Pro 3 program.
Turn on the hydrogen gas discharge tube. Aim the tip of the fiber optic cable at the tube.
To prepare Logger Pro 3 to measure light emission, open the Experiment menu and
choose Change Units — Spectrometer — Intensity.
Click | » collect|. An emission spectrum will be graphed. There are two methods of
optimizing the graph of intensity vs. wavelength.
a. Set the distance between the light source and the tip of the fiber optic cable so
that the peak intensity on the graph stays below 1.0.
b. Open the Experiment menu and choose Set Up Sensors — Show All Interfaces.
In the Spectrometer dialog box, increase or decrease the Sample Time to
optimize your plot.

When you have a suitable emissions plot, click | m step || To analyze your emission
spectrum graph click the Examine icon, [, on the toolbar. Identify as precisely as
possible each of the four wavelengths of hydrogen’s Balmer series. The third and fourth
peaks are very small but they can be identified. If your data are sufficiently precise, you
may be able to see a fifth peak at approximately 389 nm. Write down the four peaks of
the graph in the data table below.

Store the emissions data by opening the Experiment menu and choosing Store Latest
Run.

(Optional) To save your experiment file open the File menu and select Save As.... Name
the file and save it to a convenient location in your computer.

NOTE: You will need to examine your graph of the hydrogen emissions to complete the Data
Analysis section of the experiment.

9. To close the Logger Pro 3 program, select File — Exit, and follow the onscreen prompt
if you haven’t saved your data to a named file.
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Data and Analysis

1. Complete the table below. You will have recorded the wavelengths from examining the

graph of the hydrogen discharge tube emissions.

Wavelength
(nm)

Wavenumber
(m™)

Frequency
(Hz)

Photon Energy
()

n
(Balmer Series)

3

Wavelength: examine the graph and write down the peak in the specified regions.
Wavenumber = 10° / (wavelength in nm)
Frequency = (3 x 10* m/s) / (wavelength inm) Note: 1 nm=1x 10" m

Photon Energy = (frequency) x 4 Note: 7 =6.626 x 10~* m*kg-s™

Use the equation described in the introductory remarks to calculate the Rydberg constant
for the four lines in Balmer Series that you identified in the table above. For the Balmer
Series, ng=2. What is the average value for the Rydberg constant, based on your data?

A second method of determining the Rydberg constant is to analyze a graph of the values
of n in the Balmer Series vs. the wavenumber. Prepare a plot of 1/n* (X-values) vs.
wavenumber (Y-values). Calculate the best-fit line (linear regression) equation for the
plot; the slope of this line is equal to —R,,.

An accepted value of the Rydberg constant, R, is 1.097 x 10" m™. Compare your value
of R, to the accepted value.

Use the R,, that you calculated in Question #3 to predict the wavelength of the fifth line in
the Balmer Series (n = 7). Examine your graph of the hydrogen discharge tube emissions.
Does the fifth Balmer line appear in your graph? Explain.

© 2007 Ocean Optics, Inc.
Vernier Software & Technology




A

absorbance

chlorophyll, 19

spectrum of chlorophyll, 25
absorbance trace, 7
absorption, 6
Absorption spectroscopy, 6

B

Beer-Lambert Law
investigating, 12, 19
Beer's Law, 12

calibration plot, 12
Charged Coupled Device (CCD), 10
chemical reaction
determining rate law, 32
color, 7
color and wavelength, 7
complementary, 8
complementary color vision, 8

E

electronic transitions, 4

emission, 6

emission spectra, 36

Emission spectroscopy, 6

emitted, 5

equilibrium constant
spectrophotometric, 46
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Gaertner® Spectroscope, 13

Infrared spectroscopy, 4
instruments that genrerate spectra, 8
interaction of light with matter, 3

light, 1
M

molar absorptivity, 12
monochromator, 9

nitrate concentration in natural waters, 40

O

Ocean Optics USB4000 Spectrometer, 14

P

Preface, 2

Q

Qualitative spectroscopy, 6
Quantitative spectroscopy, 6

R

Rydberg constant, 53
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sample cells, 11 Ultraviolet spectroscopy, 4

spectrometer, 9 V
USB4000, 14

Spectronic 20® Spectrophotometer, 17

spectrophot.ometer, 11 Visible light spectroscopy, 4
Spectronic 20, 17
USB4000, 16 W

spectrophotometers, 7
spectrophotometric determination

of equlibrium constant, 46
spectroscope, 8, 13
spectroscopes, 8
spectroscopy, 1

absorption, 6

emission, 6

qualitative, 6

quantitative, 6

types, 4
Spectroscopy, 4
spectroscopy concepts, 1

wavelength and energy, 3
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